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About This Guide

Purpose of This Guide
This guide describes the procedures for the day-to-day operation of Visara’s Master Console
Center (MCC). It is not intended to be an in-depth technical reference guide. For detailed
technical information, consult the Administration Guide and the Scripting Guide.

Organization
This guide is organized into the following chapters:

Chapter

Topic

Chapter 1
Introducing the
Master Console
Center

Discusses what the purpose of the MCC. It
describes how to log in and out of the system,
how to view logs, and how to view active
users on the system.

Chapter 2 Alerts

Describes how to create, modify, and delete
alerts.

Chapter 3 Selecting
Consoles

Describes how to access consoles, and how to
lock and unlock consoles.

Chapter 4 System
Status Summary

Discusses how to manage systems connected
to the MCC.

Chapter 5 Managing
Scripts

Describes how to edit, create, manage, and
execute scripts.

Chapter 6 Filtered
Messages

Filtered Messages discusses viewing and
printing filtered messages.

Chapter 7
Monitoring the
Execution Log

Discusses monitoring messages about the
MCC as well as printing the execution log.

Operations Guide
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Chapter 8
Administering the
MCC

Discusses some of the features available to
administrators. The topics in this chapter are
discussed in further detail in the
Administration Guide.

Appendix A Basic
GUI Operation

Describes basic X Windows features and
operations.

Appendix B MVS
Mainframe Console
Operation Basics

Provides some hints and tips on managing
MVS consoles in association with the MCC.

The MCC Documentation Set
In addition to this manual, you may need to refer to other manuals in the MCC documentation
suite. These are:
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Software Installation Guide. Provides instructions for the initial installation
and configuration of the MCC software.



Getting Started. Contains an initial overview of the MCC, and its applications.



Administration Guide. Provides information on administering the MCC
software and hardware.



Scripting Guide. Describes how to write scripts in GCL (Global Control
Language).



Installation Preparation Guide. Contains information on how to install MCC
hardware, and prepare mainframes and servers to communicate with the MCC.



Troubleshooting Guide. Provides initial troubleshooting steps to take before
contacting Technical Support.

© Visara International 2007

Chapter 1 Introducing the Master Console Center
This chapter describes:


The windows that are open when the user logs in to the MCC system.



The Icons window.



The Master window.



Logging in and out of the MCC system.



How to view active users.

The Master Console Center (MCC) is a powerful tool allowing automation of Operations and
Data Center processes. The MCC is platform-independent so that the operator can manage
complex enterprise computing systems, including mainframe and midrange systems, through a
single console facility—the MCC terminal (a multimedia X-terminal or PC running an X
emulator).
The MCC terminal uses a Graphical User Interface (GUI). This guide assumes you have a
working knowledge of a GUI system, such as X Windows or Microsoft Windows. For basic
information on GUI operations, see Appendix A Basic GUI Operation on page 65.
This Operations Guide focuses on the operation of the MCC from the MCC terminal. For
detailed information on configuring the MCC and writing scripts, see the Administration Guide
and Scripting Guide respectively.
Note:

Operations Guide

All configuration tasks should be performed by the MCC
administrator.
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MCC Main Windows
The MCC terminal provides eight main windows that display the basic processes of the MCC and the
consoles connected to it. Each window is a gateway through which information can be viewed and
actions taken. These windows can be minimized to the Icons window and can be closed except for the
Console Selection window.
Note:
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Generally, the MCC should not be shut down. If a problem occurs
that necessitates closing down the MCC, check with the MCC
administrator before continuing.

Window

Description

Alert

Multiple Alert Windows can be opened.
Each window lists open issues regarding
systems connected to the MCC. The alert
window can be closed. For more details, see
Chapter 2 Alerts on page 17.

Console
Selection

The Console Selection window provides a list of
consoles connected to the MCC. For more
information, see Chapter 3 Selecting Consoles
on page 27.

System Status
Summary

The System Status Summary window
displays icons representing the hosts or
systems defined to the MCC. These hosts
include mainframes, Unix servers, routers,
and operating systems. Clicking on an icon
representing a host leads to more detailed
information. The consoles for each host are
viewed through the Console Selection
window. For more information on the
System Status Summary window, see
Chapter 4 System Status Summary on page
43.

Filtered
Message

The Filtered Message Display window lists
selected messages received from hosts
connected to the MCC. Part of the
configuration process is to set the filtering of
messages displayed here. For more details, see
Chapter 6 Filtered Messages on page 55.

© Visara International 2007
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Execution Log
Display

The Execution Log Display window displays
a log of the activities of the MCC. Such
activities include, for example, the programs
that are running, script errors, and execution
messages. The information displayed for
each activity includes date, time, designation,
and a preset message. For more information,
see Chapter 7 Monitoring the Execution Log
on page 59.

Master

From the Master window, you can view
active users, log out of, and administer the
MCC. For more information about
administering the MCC, see Chapter 8
Administering the MCC on page 61.

Icons

The Icons window is where all MCC
windows are minimized. For more
information, see Icons Window on page 12.
Table 1. Description of MCC Windows.

Operations Guide

11

Visara Master Console Center

Icons Window
Master Console Center windows are accessed from or minimized to the Icons window. This
window is always open when the MCC is operational. Double-click an icon in the Icons window
to restore that window for use.

Figure 1. Icons window.

Note:
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The descriptions in this guide assume the MCC GUI is running on an
X-terminal, in which case the Icons window appears as a MCC
window. If running the GUI through an emulator in Microsoft
Windows or in the CDE (Common Desktop Environment), it is
possible to configure the window manager not to use a separate icon
window. In this case, the windows are simply minimized in the top
left or bottom right corner of the screen. For example, it is possible
to configure the Exceed emulator to use the Microsoft Windows
window manager; in this case, the MCC windows are minimized to
the task bar at the bottom of the screen. Refer to the documentation
for the emulator or CDE for information on the configuration steps
required.
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Master Window
From the Master window, it is possible to:


View active users. (See Viewing Active Users on page 15.)



Log out of the MCC system. (See Logging Out on page 14.)



Edit, execute, and manage scripts. (See Editing, Executing and Running Scripts
on page 48.)



Administer the MCC system. (See Administering the MCC on page 61 and the
Administration Guide for details.)



Send a broadcast message to the current MCC users. (See Sending a Broadcast
Message on page 16).

Figure 2. Master Window.

If the Master window is not open, double-click the Master window icon in the Icons window. For
more information about the Icons window, see Icons Window on page 12.

Logging In
Your site may utilize a common user ID that is never logged out, or it may set up several user
IDs. Perhaps there may be an ID for administrators and an ID for all other users. Setting up
different IDs allows users to have different levels of access to the MCC. For example, only those
people who have an administrator ID may be given access to a certain console.
If the site uses different IDs and the previous user logged out, the XDMCP Display Manager
Chooser window (sometimes referred to as the Tek host menu) is displayed. If the previous user
did not log out, log out and then log back in under your user ID. See Logging Out on page 14.

Operations Guide
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To log into the system:
1. If more than one MCC system is listed, double-click on the desired MCC system.
The login screen opens.

Figure 3. Typical Login Screen.

Note:

The login ID and password are case sensitive. To obtain a login ID
or password, contact the MCC administrator.

2. Enter the login ID in the login text box and press Return.
3. Enter the password in the Password text box.
4. Press the Return key. The MCC Main windows open.

Logging Out
If your site uses multiple login IDs, log out at the end of a MCC session. This allows the next
person to log in to the session under their own login ID. Logging out is done from the Master
window. If the Master window is not open, double-click the Master window icon in the Icons
window. This opens the Master window. For more information about the Icons window, see
Icons Window on page 12.
To log out:
1. Select the User menu Logout option. The Exit Confirmation window asks, "Do
you really wish to log out of the MCC?"
2. Click the OK button. The system then returns to the XDMCP Display Manager
Chooser window.
Click the Go Back button to exit the dialog without logging out, and return to the
Master window.

14
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Viewing Active Users
To view information about each active user logged into the MCC system, select the Active Users
window. The Active Users window displays information such as all current users, login name,
full name, and any comments provided by the system administrator.
Note:

The list of users includes any active users of the gwcharcons facility
described in the Administration Guide.

To view the active users, the Master window must be open. If the Master window is not open,
double-click the Master window icon in the Icons window. This restores the Master window.
For more information about the Icons window, see Icons Window on page 12.
To view active users:
1. From the Master window, select the User menu Active Users option. The Active
Users window opens.

Figure 4. Active Users Window.

2. Click the OK button to close the Active MCC Users window.

Operations Guide

15

Visara Master Console Center

Sending a Broadcast Message
Any MCC user who is a member of a group that has the appropriate security permissions can send a
broadcast message to all other MCC users.
To send a broadcast message:
1.

Select the User – Broadcast Message menu option. The Broadcast Message
dialog box appears.

Figure 5. Broadcast Message Dialog Box

2.

3.

Type the text of the message into the dialog box, and click Send to transmit
it.


The following shortcut keys are available: ^X (Cut), ^C (Copy), and ^V
(Paste). These keys may also be used to cut, copy, and paste text to and
from other MCC applications such as the Screen Editor.



The Enter key may be used to send the message instead of clicking Send.



To include a CRLF (carriage return-line feed) in the message text, enter
^J (Ctrl+J). If multiple lines of text are copied into the dialog box from
the Screen Editor, CRLF characters are retained – each CRLF is
displayed as a “V” over a “T”.



Message lines are centered in the dialog box. The length of message
visible is determined by the resolution of the user’s display. If a message
is sent which is longer than can be viewed on the receiving user’s
display, the message is centered in the dialog box, and characters may be
cut off the front and end – no scroll bars are provided.

The sender sees a confirmation message containing “CONFIRMATION”
followed by the message text. Receiving users see a dialog box containing
“ATTENTION BROADCAST MESSAGE FROM <USER>”, followed by
the message text, where <USER> is the name of the sender. In both cases,
select OK to close the message box.
Note:
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Broadcast messages are not sent to users of gwcharcons.
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Chapter 2 Alerts
Each Alert window displays certain alerts (based on any filtering criteria provided), together with
the state of each alert—new, open, or closed. An alert remains on the screen until a user or a
script deletes it. Users and scripts can update the alerts by changing the status, state, or any other
field of an alert. Therefore, the system can be configured to generate an alert whenever it is
necessary to ensure that an operator will respond to an event or problem as well as inform the
user of automated responses in action.
Alerts can be created three ways:


The Event Manager program can create alerts using the Create Alert action. The
MCC administrator defines alerts through the Event Manager. See the
Administration Guide for more information.



Scripts can create, modify, and delete alerts. See Chapter 5 Managing Scripts on
page 47 for a basic description of how to work with scripts. For more
information about scripting, see the Scripting Guide.



Users can manually create, modify, and delete alerts. This chapter discusses
creating, modifying, and deleting alerts.

Operations Guide
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Alert Window
An Alert window displays alerts generated by the MCC in response to abnormal conditions in the
monitored systems. Each alert displays on a single line. If there are more alerts than can be
displayed in the space available, a scroll bar will appear. Alerts can be created by a user, by a
script, or by Event Manager rules.

Figure 6. Alert Window.

From the Master Window (see Master Window on page 13), select the Window menu New Alert
Window option. The Alert window defaults to display all alerts known to the MCC. For more
information about the Icons window, see Icons Window on page 12.
To change the display font of the Alert window, select the Font menu Small, Medium, or Large
option. The display is updated.

18
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Table 2 describes the fields found in an alert. The Alert Window only displays those fields
marked with an asterisk (*) – you must double-click an alert to see all the fields.
This Field:

Describes:

Sequence

The unique sequence number of an alert
for tracking purposes.

*State

If the alert is New, Open, or Closed.

Status

The numeric status and color of the alert.
The lower the number, the higher the
criticality.

*Source

The name of the device or operating
system associated with the alert.

*Message

The text of the alert.

*User Note

Comments entered by a user and
automation generated (scripts and Event
Manager) comments. For example,
comments may describe the resolution
process or provide instructions to the
user from a script.

*Time: Create

The date and time the alert was created
(state of New).

Time: Open

The date and time the alert was marked
as Open. That is, the date and time an
operator acknowledged the alert.

Time: Close

The date and time the alert was marked
as Closed.
Table 2. Alert Window Fields

Usually, the state of progression for alerts is New to Open to Closed, resulting in date updates as
appropriate. However, an alert may proceed directly from New to Closed, at which point a date
will not be filled in for Open.

Operations Guide
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Alert Window Shortcuts
The following keyboard shortcuts are provided in the Alert window.
This Option:

Does This:

Return and Enter
key

Edits the selected alert. Only one alert can be
selected at a time. If more than one alert is
selected, clicking the Return or Enter key has
no effect.

Delete or Backspace
key

Deletes the selected alerts.

Insert key

Opens the New window.

Esc

Deselects all alerts.

F10 key

Minimizes the Alert window to the Icons
window.

Home key

Moves to the top of the alert list.

End key

Moves to the end of the alert list.

PageUp and
PageDown key

Move the screen up and down one screen,
respectively.

Up and Down Arrow

Scroll to the previous or next alert,
respectively.

Ctrl-A

Selects all alerts in the Alert window.

CTRL-Click an alert

Selects multiple alerts. If alerts were already
selected, using the CTRL key adds an alert to
the current selection of alerts.
Note: If the alert was already selected, this
action deselects the alert.

Click-Drag

Selects or deselects a range of alerts.

Double-click an alert

Opens an alert for editing.

SHIFT- Click an
alert

Adds a range from previous selected alert to
new "anchor" alert. This will work across any
number of "pages" of alerts.
Table 3. Alert Window Shortcuts
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Opening Multiple Alert Windows
It is possible to display several Alert windows at the same time. For example, each window may
display only the alerts for a specific system.
To open additional Alert windows:
1. From the Master Window (see Master Window on page 13), select the Window
menu New Alert Window option.
2. The new window defaults to showing all alerts on the MCC. Position and size
the window, and apply any filters as desired. See Filtering Alerts on page 24 for
more information on filtering.

Creating Alerts Manually
To manually create an alert:
1. Select the Alert menu New option. The New Alert window opens.

Figure 7. New Alert Window.

The Sequence text box is automatically filled in with a number representing the
sequence the alert was created.
2. To define the status of the alert, select a status color from the Status drop-down
list box.
3. To select the name of the CPU or operating system that the alert affects, enter the
source in the Source text box.

Operations Guide
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4. Enter a message in the Message text box. The message appears on the Alert
window and when the alert is opened.
5. Enter a note in the User Note text box. This is optional.
6. The time group box is automatically updated when you click the OK button.
7. Click the OK button. The alert is added to the Alert window.

Modifying Alerts
From the Modify Alert dialog, alerts can be changed or the user notes associated with an alert
viewed.
To modify an alert:
1. Click the alert you want to modify.
2. Select the Alert menu Modify option or double-click the desired alert. The
Modify Alert window opens.

Figure 8. Modify Alert Window

The Sequence box and Times group are automatically filled in. The number in
the Sequence box is a unique identifier for internal tracking purposes. The
Times group is filled in or updated when the OK button is clicked.
3. To change the status of the alert, click the Status pop-up menu button. Select the
number/color representing the desired new status for the alert.
4. To change the source, enter the CPU or operating system to which the alert
refers.

22
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5. To change the message appearing on the Alert window, enter a message in the
Message text box.
6. To include a note, enter a message in the User Note text box.
7. Click the OK button to save the changes. When prompted to verify the changes,
click the Yes button to accept the changes and update the main window.
Click the Cancel button to exit the dialog without saving any changes

Deleting Alerts
Alerts can be deleted from the Alert window. All alerts (both current and deleted) are
permanently stored in the Alert log file.
To delete an alert:
1. Select the alert to delete. To select more than one alert, hold down the Shift or
Control keys while selecting the alerts.
2. Select the Alert menu Delete… option. The alert is deleted.

Operations Guide
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Changing Alert State
The state of any alert may be changed manually. For example, an alert viewed on the Alert
window may be ‘new’ and require operator action. To acknowledge the alert, change the state to
‘open.’ Once the task is finished, change the status of the alert to ‘closed’ to let other users know
that the task is complete.
To change to status of an alert, select the Alert menu Change Status — Open or Change Status
— Close option.

Filtering Alerts
It is possible to limit the display of alerts in the Alert window, to only show selected Alerts.
To open the Alert Filter Dialog window, select the View menu Filter Alerts… option.

Figure 9. Alert Filter Dialog Window.

Any regular expression can be entered in the Alert Message and/or Alert Source entry boxes.
Clicking the Apply Filter button activates the filter and modifies the Alert window display
immediately.
To remove filtering and display all alerts, click the Remove Filter button.
To close the Alert Filter Dialog window, click the Close button.

24
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Opening an Alert Source’s OS Console
Sometimes an Alert may be displayed which requires operator intervention on a particular
console attached to the MCC. Instead of searching for the console button in the Console
Selection Window (see page 28), open the console window directly from the Alert window.
With the desired alert highlighted, select the View menu OS Console… option as shown in
Figure 10. Alert OS Console Window.

Figure 10. Alert OS Console Window.

The OS Console corresponding to the Source of the selected Alert will open. (In this example,
the AIX console would open.)

Operations Guide
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Chapter 3 Selecting Consoles
This chapter discusses how to:


Select consoles that are connected to the Master Console Center.



Access consoles.



Manually lock and unlock consoles for editing.



Use soft keys.

All consoles connected to the MCC are listed on the Console Selection window. This window
allows any of the consoles to be selected from a single point of access. You can type on any of
the consoles connected to your MCC, eliminating the need for multiple physical consoles in the
data center.
The Console Selection window is minimized when you log in to the MCC. To open it, doubleclick the Console Selection icon located in the Icons window. For more information, see Icon
Window on page 12.
Note:

Operations Guide

If a console does not appear in the Console Selection window, check
with the MCC administrator. You may not have the proper security
access to that console.

27

Visara Master Console Center

Console Selection Window
The Console Selection window displays all consoles connected to the MCC.

Console Tabs
The tabs at the top of the Console Selection window identify the different classifications of
console types, for example, hardware, operating systems, and printers.

Figure 11. Console Selection Window.

Clicking any tab along the top except ALL displays only the consoles for that classification.
Table 4 explains the tabs:

28
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This Tab

Lists

All

All consoles defined to the MCC.

Hardware

Consoles defined as the hardware console to a
CPU.

OS

Consoles defined as the operating system console
to an operating system.

Other

Only consoles that are not defined as hardware,
OS, or printer consoles. For example, consoles
listed here are usually additional consoles or
programs opened via a command.

Printer

Consoles defined as the printer console to an
operating system. This only shows mainframe
printer consoles. Printer consoles are view only,
and are useful for checking the messages from the
connected consoles.
Table 4. Console Selection Window Tabs.

User Defined Categories
The left side of the Console Selection Window displays User Defined Categories. They work in
coordination with the tab selections along the top to narrow down a view of many consoles.

Filtering Console Choices
Once a tab is selected along the top, select one or more User Defined Categories by holding down
the shift or control keys, and single clicking. The control key on its own selects and deselects
categories. Shift allows a range of consoles to be selected. Then, select either the AND or the
OR square radio button. When multiple User Defined Categories are selected, the AND button
displays consoles that are in any one of the selected categories.
Refer to the Administration Guide for more information on defining User Defined Categories.

Operations Guide
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Console Status Indications
Console status is shown by the color of its icon in the Console Selection window, and the
corresponding character indication in gwcharcons. Use the following tables to interpret the
indications available:
Host issue

MCC issue

Normal

GUI Indication

Red Icon

Yellow Icon

Green Icon

gwcharcons Indication

* Character

? Character

No Character

Table 5. Console Status

Accessing Consoles
Access consoles connected to the MCC using the Console Selection window. An icon in this
window represents each console.
To access a console connected to the MCC:
1. Open the Console Selection window. See Console Selection Window on page 28
for more information.
2. Click the icon representing the console to access from the Console Selection
window using either the left or right mouse button.
-

To open multiple Display Console windows—each window representing a
different console—use the right mouse button.

-

To open a Display Console window that will replace the last opened Display
Console window, use the left mouse button. That is, if you have a Display
Console window open and use the left mouse button to open another Display
Console window, the new console window replaces the existing console
window.
Notes: Use either the left or right mouse button to open the first console
window. A maximum of fifty console windows may be open at any
time.
If a user’s console window becomes slow or unresponsive to the
MCC’s console manager program (for example, because of excess
message traffic), the MCC will disconnect from the specific user’s
console window, and log an error message. This prevents negative
effects on other users.
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The Display Console window opens.

Figure 12. Display Console Window.



Use the Display Console window in exactly the same way as the actual console.



To close the Display Console window, select the Window menu Close Window
option.



The status line at the bottom of the window shows the identity of the user who
locked the console and the position of the cursor. The lock field is not shown if
the console is unlocked (see Locking & Unlocking Consoles on page 39).
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Viewing the Console History Log
The Console History Log contains recent event messages for a console. It may be used to view
messages that have scrolled out of the active console window.
To open the Console History Log for the current console, select the Console History option from
the Window menu. Messages are displayed in the normal format for the console with a date and
time stamp inserted at the beginning of each message.
History logging must be enabled for each console by the MCC administrator. If no console
history log is available, contact the administrator. Refer to the Administration Guide for detailed
information on the Console History Log.
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Using HP700 Consoles
The HP700/92 Unix console emulation provided by the MCC is designed to support applications
such as SAM and NMMGR; other applications that are not run at a console may not function
correctly. The emulator functions only in HP mode – no EM modes are implemented.
Note:

The environment variable TERM must be set to hp. Other values of
TERM may be available – check the terminfo/termcap entries.

The following keys have special functions in this emulation. Other keys and combinations have
the same functions as on a standard HP keyboard.
Key or Key Combination

Function

F11

Clears the current line.

F12

Toggles between the modes, user, and
system function key sets. This key is
only available when one of these key sets
is displayed.

Shift+Up Arrow

Scrolls up. The top line is removed.

Shift+Down Arrow

Scrolls down. The bottom line is
removed.

Table 6. HP700/92 Console Emulation, Supported Special Function Keys

The following command sequences are available in this emulation:
Key Sequence

Function

<ESC>'

Sense cursor position relative.

<ESC>^

Return terminal primary status.

<ESC>~

Return terminal secondary status.

<ESC>[

Start an unprotected field.

<ESC>{

Start a transmit only field.

<ESC>]

End a field.

<ESC>1

Set tab.

<ESC>2

Clear tab.

<ESC>3

Clear all tabs.

<ESC>I

Horizontal tab.

<ESC>I

Back tab.

<ESC>4

Set left margin.
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Key Sequence

Function

<ESC>5

Set right margin.

<ESC>9

Clear all margins.

<ESC>A

Cursor up.

<ESC>B

Cursor down.

<ESC>C

Cursor right.

<ESC>D

Cursor left.

<ESC>E

Hard reset.

<ESC>F

Cursor home down.

<ESC>G

Move cursor to left margin.

<ESC>H

Cursor home up.

<ESC>J

Clear display from cursor to end of
memory.

<ESC>K

Clear line from cursor to end of line.

<ESC>L

Insert line.

<ESC>M

Delete line.

<ESC>N

Start insert char with wraparound mode.

<ESC>O

Delete char with wraparound.

<ESC>P

Delete char without wraparound.

<ESC>Q

Start insert char mode without
wraparound.

<ESC>R

End insert character mode.

<ESC>S

Roll up.

<ESC>T

Roll down.

<ESC>U

Next page.

<ESC>V

Previous page.

<ESC>W

Format mode on.

<ESC>X

Format mode off.

<ESC>a

Sense cursor position absolute.

<ESC>b

Unlock keyboard.

<ESC>c

Lock keyboard.

<ESC>d

Send a block of data to the computer.
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Key Sequence

Function

<ESC>g

Soft reset.

<ESC>h

Cursor home up, ignoring transmit
fields.

<ESC>&a<col>c<row>Y

Move cursor to column <col> and
row <row> relative.

<ESC>&a<row>y<col>C

Move cursor to column <col> and
row <row> relative.

<ESC>&a<row>Y

Move cursor to row <row> relative.

<ESC>&a<col>C

Move cursor to column <col> relative.

<ESC>&a<col>c<row>R

Move cursor to column <col> and
row <row> absolute.

<ESC>&a<row>r<col>C

Move cursor to column <col> and
row <row> absolute.

<ESC>&a<row>R

Move cursor to row <row> absolute.

<ESC>&a<col>C

Move cursor to column <col> absolute.

<ESC>&a<+,-><col>c<+,-><row>Y Move cursor to column <col> and
row <row> relative.
<ESC>&a<+,-><col>c<+,><row>R

Move cursor to column <col> and
row <row> relative.

<ESC>&a<+,-><col>C

Move cursor to column <col> relative.

<ESC>&a<+,-><row>R

Move cursor to row <row> relative.

<ESC>&dS

Start a security field.

<ESC>&ds<char>

Enable security fields and any other
enhancements selected.

<ESC>&d<char>

Select display enhancements.

<ESC>&f<0-2>a<18>k<lableLen>d<stringLen>L<lab
el><string>

Defines a function key.

<ESC>&f<1-8>E

Executes a function key.

<ESC>&j@

Remove the function key labels from
the screen.

<ESC>&jA

Display the modes set of function key
labels.

<ESC>&jB

Display the user key labels.
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Key Sequence

Function

<ESC>&jC

Disable screen messages, and
redisplay function key labels.

<ESC>&jR

Enables the user/system key.

<ESC>&jS

Disables the user/system key.

<ESC>&j<0-3>D

Select bell, CR, function key labels
options.

<ESC>&j<x>L<message>

Remove key labels and display the
message.

<ESC>&k0\

Select HP mode.

<ESC>&k<0,1>A

Auto line feed mode off/on.

<ESC>&k<0,1>B

Turn block mode off/on.

<ESC>&k<0,1>C

Caps lock mode off/on.

<ESC>&k<0,1>D

Keyboard bell off/on (BELL is only
rung once).

<ESC>&k<0,1>K

Auto keyboard lock mode off/on.

<ESC>&k<0,1>L

Local echo mode off/on.

<ESC>&k<0,1>M

Modify all mode off/on.

<ESC>&k<0,1>P

Caps mode off/on.

<ESC>&k1R

Remote mode on.

<ESC>&k<0,1>]

Set meaning of ENTER keys.

<ESC>&p<4,6>^

Request printer status supported so
no hang can occur.

<ESC>&p9^

Query number of blocks assigned to
forms cache; supported so no hang
can occur (700/94,700/98,700/98ES).

<ESC>&s<0,1>A

Set 'Xmit Fnctn' off/on.

<ESC>&s<0,1>B

Turn off/on SPOW.

<ESC>&s<0,1>C

Turn off/on inhibit end of line wrap.

<ESC>&s<0,1>D

Set line/page field.

<ESC>&s<0,1>G

Turn off/on inhibit handshake field.

<ESC>&s<0,1>H

Turn off/on inhibit DC2 field.

<ESC>&w12F

Turn on display.
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Key Sequence

Function

<ESC>&w13F

Turn off display.

<ESC>&w6f<80,132>X

Select number of columns.

<ESC>&x<0,1>C

Turn off/on send cursor position mode.

<ESC>*d0E

Normal display.

<ESC>*dQ

Cursor on.

<ESC>*dR

Cursor off.

<ESC>*d0Q

Select underline cursor.

<ESC>*s^

Return terminal identity.

<ESC>*s<-1,-2,-3,-4>^

Return terminal capabilities.

<ESC>*y^

Return downloadable character set
capabilities.

Table 7. HP700/92 Console Emulation, Supported Command Key Sequences

Unsupported Features
This emulation does not support the following features.


Configuration menus for setting terminal modes.



Support for printers, modems, or other external devices.



Memory lock mode.



EM52, EM100, and EM220 mode commands.



Bell commands.



Cursors other than a non-blinking block cursor.

The following commands are not supported by this emulation.
Note:

<ESC> indicates the escape key. <x>, <y>, and <z> are parameters
to commands:

Key Sequence

Function

<ESC>@

Stop data transmission from the terminal
for one second.

<ESC>0

Copy terminal memory to selected
destination

<ESC>f

Disconnect the modem.

<ESC>l

Begin memory lock mode.

<ESC>z

Initiate a self test of the terminal.

Operations Guide

37

Visara Master Console Center

Key Sequence

Function

<ESC>&fR

Set the Return key to the non-volatile
memory selection.

<ESC>&k<x>J

Select the CRT refresh rate.

<ESC>&k1\

Select EM220 mode from HP mode.

<ESC>&k<x>

Turn smooth scroll mode off/on.

<ESC>&k<x>I

Set data bits and parity.

<ESC>&k<x>Q

Set key click off/on.

<ESC>&k0R

Turn local mode on.

<ESC>&p<x>D

Select device as destination device.

<ESC>&p<x>u<y>p<z>C

Perform action on external device.

<ESC>&p<x>W<string>

Transfer data from computer to
destination device.

<ESC>&Pw<string>

Transfer ASCII data from computer to
selected device.

<ESC>&p<x><y>d<z>
D

Copy data to destination device.

<ESC>&pB

Copy cursor line from display to the printer.

<ESC>&pF

Copy display from cursor line to last
displayed line to printer.

<ESC>&pM

Copy memory from cursor line to end of
memory to printer.

<ESC>&p0B

Copy cursor line from display to printer.

<ESC>&p0F

Copy display from cursor line to last
displayed line to printer.

<ESC>&p0M

Copy memory from cursor line to end of
memory to printer.

<ESC>&q<x>L

Unlock/lock the configuration menu.

<ESC>&s<x>N

Turn the escape transfer field off/on.

<ESC>*d1E

Inverse display.

<ESC>*d1Q

Select a block cursor (the cursor is
always a green block cursor).

Table 8. HP700/92 Console Emulation, Unsupported Command Key Sequences
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Using Command Consoles
Command console buttons run a defined command or script when selected. The command or
script may provide a console to a CPU or OS, or may run a specific program or application. The
functionality of a command console is defined by the MCC Administrator, as described in
Chapter 8 of the Administration Guide. Command console buttons appear on the appropriate tabs
of the Console Selection window, Hardware if associated with a CPU, OS if associated with an
OS, or Other for other console types. All command buttons also appear on the ALL tab.

Locking & Unlocking Consoles
Since multiple users and automation routines have access to each console attached to the MCC,
an automatic locking feature exists to prevent errors such as overtyping from occurring. When
locked, the console status bar of the Display Console contains the name of the user or script that
has locked the console. Only the user who locks a console is allowed to type on that console.

Figure 13. Display Console Status Indications
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Before automation routines (for example, scripts or Event Manager rules) send characters to a
console, they first lock the console and then send the characters. When finished, the console is
immediately unlocked.
When manually typing on a mainframe console, as soon as an attention-type key (<Enter>,
<PA2>, etc) is pressed, the console is automatically unlocked. However, on RS232 and telnet
consoles, the concept of the attention key does not exist because pressing <Enter> is not a reliable
method. (Typing in an editor is a perfect example of this - how many times is <Enter> pressed?
If <Enter> unlocked the console, the editing session could be interrupted by typing from another
user or automation routine.)
When manually typing on RS232 and Telnet consoles, the console remains locked until one of the
following events occurs:

40



The console timeout feature removes the lock. The default timeout is 30
seconds. For additional information on setting the console timeout seconds, see
the Administration Guide.



The user manually unlocks the console with the Unlock Port option on the
console menu.
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Manually Locking Consoles
A console may be locked manually, ensuring that only the person who locked the console has
access to it. This prevents other users and scripts from simultaneously typing on the console.
However, use of this option is generally not needed due to the automatic console locking feature.
To lock a console:
1. Select the console to lock from the Console Selection window.
2. Select the Windows menu Lock Port option. The port is now locked.
Note:

The console will still be automatically unlocked according to the
unlock rules specified in Locking and Unlocking Consoles on page
39.

Manually Unlocking Consoles
You can manually unlock any locked console that you previously locked. However, if you try to
unlock a console that is locked by a script, the script immediately re-locks the console. If you try
to unlock a console that was locked by another MCC user, the console will remain locked.
To unlock a console:
1. Select the console to unlock from the Console Selection window.
2. Select the Windows menu Unlock Port option. The console is now unlocked.
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Using Soft Keys
Soft keys provide an easy way to send keys that are not always obvious or even present on a
keyboard. The ‘Start’ and ‘Stop’ keys on mainframe hardware consoles are such an example.
Another example is the Break key on RS232/VT100 consoles.
A MCC system comes with a predefined set of soft keys. When defining soft keys, individual
keys such as F2 may be sent, or mathematical equations such as ‘2+2’. To change the existing set
of soft keys, contact the MCC administrator.
To use soft keys:
1. From the Display Console window, select the Window menu Soft Keys option.
The Soft Keys window opens, displaying the specific soft key set for that
console’s terminal emulation.

Figure 14. Example Soft Keys Window.

2. Click the key (or sequence of keys) to send to the console.
3. If you selected a mathematical equation, click the Enter key.
4. Select the File menu Close option.
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The System Status Summary window provides an overview of the systems connected to the
Master Console Center. The configuration of this window is determined by the MCC
administrator.
This chapter describes:


Using the System Status Summary window.



Managing the status of the system.
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Managing System Status
Managing system status requires an understanding of how all the systems connected to the MCC
work together. All systems can be viewed from the System Status Summary window:

Figure 15. System Status Summary Window

The System Status Summary window looks different from system to system, because this
window represents all systems connected to the MCC. The MCC administrator determines the
actual look of the window.
Figure 16 defines the Icons represented in the System Status Summary window.

Figure 16. Icons on the System Status Summary Window.

Each system connected to the MCC is represented by the CPU and operating system(s) associated
with that CPU. Each system on the System Status Summary window is grouped together with a
box around the system. There may be more than one operating system running on each CPU
(mainframe LPARs, for instance), and there will likely be more than one system associated with
the MCC. Double-clicking an icon will open a window describing more about the selected
system.
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This Icon

Opens:

CPU

The Hardware Configuration window, to view a
log of the CPUs, change the status, view the
configuration of the hardware, and view the
channel distribution.

Operating
System

The Task List (TaskMan) window, to view the
tasks defined for the selected operating system.

Group

Another System Status Window containing CPU
and Operating Systems defined in that group.
(The MCC Administrator may choose to put
several systems in a group to organize them.)
Table 9. Description of System Icons.
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Changing an Icon Status
The status of an icon on the System Status Summary window may be changed, for example, to
show that an error has been corrected.
To change the status of an icon:
1. Click the icon to change the status or color.
2. Select the Select menu Icon option. The ICON Control window opens.

Figure 17. Icon Control Window.

3. Select the color from the Color list box.
4. Enter a message in the Message text box. This message appears at the bottom of
the icon on the System Status Summary window.
5. Optional. Enter user name in the Operator Name box.
6. Optional. Enter a comment in the Log Comment box.
7. Click the OK button.
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This chapter describes how scripts can be created, managed, and edited.
Scripts are a series of written instructions using the Global Control Language (GCL), allowing
automation of tasks normally completed by an operator or administrator. GCL allows a user full
control over the entire MCC system. Almost all manual operations can also be performed by
scripts.
Refer to the Scripting Guide for details of how to write scripts.
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Editing, Executing and Running Scripts
Edit, execute, and run scripts from the Script menu options. For example, to edit an existing
script, select the Script menu Edit option, as shown in Figure 18.

Figure 18. Script Edit Option.

When you select the Script Edit option, the File Editor is displayed. The File Editor is a fullfeatured text editor, complete with copy, paste, and find-and-replace functions. Below the File
Editor menu bar is a window displaying the current location of the cursor.
When saving a script, the script is automatically compiled and the results are displayed in the
Execution log. If an error was found, a pop up message is also displayed.
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Editing a script
A script can be edited once it is opened.
To edit a script:
1. Select the Script menu Edit option. The Open File window displays.

Figure 19. Open File Window.

2. Select the directory containing the script from the Directories list box. The
default is the current directory.
3. Select the script to edit from the Files list box, or double-click the script to be
edited from the Files list box.
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4. Click the Open button. The Edit window opens.

Figure 20. Script Editor Window.

5. Edit the script.
6. To save the script, select one of the following options from the File menu:

50

-

Select Save to save the script as an existing name.

-

Select Save As to save the script as a different name, or to save a new,
unnamed script.
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Creating a script
Scripts can be created that run automatically when certain conditions occur.
To create a script:
1. Select the Script menu Edit option. The Open File window opens (see Figure
19).
2. Click the Cancel button. The Edit File window opens with a blank screen (see
Figure 20).
3. Type the script.
4. Select the File menu Save As option. The Save File window opens. The script
directory is selected by default. Visara recommends saving all scripts in this
directory.
5. Click the Save button. The script automatically compiles. A warning message is
displayed if the script has a problem compiling. If a warning appears, click the
OK button to clear the warning.
Note:

Look in the Execution Log Display window to view the errors that
the compiler found in the script. If no errors were found, a message
will be displayed indicating so.

After saving the script, the Edit File window is redisplayed. Click the File menu
Close option of the Edit File window.
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Managing Scripts
The Script Manager allows a user to control all aspects of script execution within the system from
one location.
To manage scripts:
1. Select the Script menu Manage option. The Script Management window opens.

Figure 21. Script Management Window.

The Script Management window displays the following information about active
scripts (scripts that are currently executing):
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Name of Column

Description

No.

Script’s Initiator number (a unique ID
specifying the script).

Class

Room, CPU, or operating system (OS).

Name

Name of the room, CPU, or operating
system on which the script is operating.

Script

Name of script being executed.

Status

Current point in execution (the step
that the script is processing).

PID

Process ID of the script.

Line

Line number being executed.

Command

Actual command being executed.

Executed

Number of commands executed by the
script.

Remain/Wait

If a script has a command which is
waiting for a fixed time, this area
indicates how many seconds are
remaining of the total wait time.

Table 10. Columns in the Script Management Window

To pause, resume, skip, or cancel the execution of a script, first select the script in the Script
Management window then choose one of the following buttons:


Pause. Temporarily halt execution of the selected script.



Resume. Resume execution of an already paused script.



Skip. Cancel the execution of the wait in the selected script and resume with the
next line in the script.



Cancel Execution. Halt the execution of a selected script.



Close. Close the window without changing script operation.

To use one of the above buttons, first select the appropriate script in the Script Management
Window by clicking on it.
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Executing Scripts
Scripts may be executed manually, or run automatically when certain conditions occur. The
Script Execution window allows a user to immediately execute a specific script.
To execute scripts:
1. From the Script menu, select the Execute option, or type Ctrl-X. The Script
Execution window opens.

Figure 22. Script Execution Window.

Script source code is saved with a .scr extension. Once the script is successfully
compiled, scripts will have an .scx extension. All scripts that are available to run
are displayed in the Files list box.
2. Select the desired script by clicking on it.
3. Select the location to run the script from the ROOM, CPU, or OS list boxes.
You can only select one location.
The Selection box is automatically filled in according to the location you
selected.
4. Click the Exec button to run the script. Alternatively, click the Cancel button to
exit the dialog without running the script.
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Chapter 6 Filtered Messages
This chapter discusses:


Viewing a filtered list of messages.



Printing the list of filtered messages.

A filtered list of messages is displayed in the Filtered Message Display window.
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Viewing Filtered Messages
The Filtered Message Display window shows a filtered list of messages received from devices
connected to the MCC. The MCC, by default, is set to display none of the messages received
from the devices connected to it. Messages are logged to the Filtered Message Display window
by a LOG script command or the Event Manager “LOG to Filtered Message Window” action.
While the window is open, it is updated with new messages as they are received if the cursor is
located at the end of the list of messages. If the cursor is located elsewhere in the list, scroll down
to view new messages.
Each message can be color-coded. Part of the installation process is to set the filtering for
messages that are displayed in this window. For more information about filtering messages and
establishing color coding of messages, see the Event Manager chapter of the Administration
Guide and the LOG script command in the Scripting Guide.
This window allows a single point for viewing selected messages received from consoles
connected to the MCC.

Figure 23. Filtered Message Display.
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The Filtered Message Display window contains four fields:

Date

The date the message is generated. The date is
displayed with the year/month/day format.

Time

The time the message is generated.

Message Source

The name of the script that logged the message
or the name of the Operating System name the
message came from.

Message
Content

The content depends upon the device, event,
etc. that generated the message. It can be a
“raw” message, a reworded message, or a
completely new message.
Table 11. Filtered Message Display Window Fields

The Filtered Message Display window can be minimized but not closed. Click on the minimize
button in the upper right hand corner of the window to minimize it to the Icons window.

Printing Filtered Messages
The current screen or all messages in the Filtered Message Display window can be printed.
To print the current screen, select the Select menu Print Screen option. The currently displayed
screen of messages is printed.
To print all of the messages, select the Select menu Print All option. All of the messages in the
Filtered Message Display window file buffer are printed.
Note:
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Selecting the Print All option can print up to 10,000 messages. At 60
lines per page, this requires more than 165 pages of paper.
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Chapter 7 Monitoring the Execution Log
MCC status is monitored through the Execution Log Display window. This window displays
information such as start up and shutdown time and date, script start and end times, user login and
logouts. The color of a message indicates status (relative level of importance).
While the window is open, it is updated with new messages as they are received if the cursor is
located at the end of the list of messages. If the cursor is located elsewhere in the list, scroll down
to view new messages.
When a user logs into the MCC, the Execution Log Display window opens. If the Execution Log
display window is not open, see Icon Windows on page 12.

Figure 24. Execution Log Display Window
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Printing the Execution Log Display
The messages on the screen of the Execution Log or all of the messages in the Execution Log can
be printed.
To print only the messages on the screen, select the Select menu Print Screen option.
To print all of the messages contained within the Execution Log Display, select the Select menu
Print All option.
Note:
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The Execution Log Display window can hold up to 10,000 messages.
At 60 lines per page, this requires more than 165 pages of paper.
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Chapter 8 Administering the MCC
This chapter provides an overview of how to administer the MCC. For a more detailed
description of the administration features, see the Administration Guide.
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Selecting Administration Features
The Master window is open whenever a user is logged on to the MCC. In the lower right of the
menu bar, the user's identity and the current date and time are displayed. Administration options
are selected from the Administration menu option.

Figure 25. Master Window, Administration Option
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Configuring the MCC
Configure the MCC through the Administration menu:Configuration submenu. A brief
description of each menu option is given in Table 12. See the Administration Guide for detailed
instruction in the use of each option.
Use This Menu Item

To

User Messages

Edit the configuration file that determines
what strings are shown when a log message
is double-clicked in a window.

Security

Open the Security Editor, which is used to
designate security permissions to MCC users
and groups as well as create, edit, and delete
users.

SNMP Setup

Open the SNMP Setup Editor, which is used
to define SNMP agents and agent groups.

Event Editor

Open the Event Editor, which configures
Event Manager's rules and actions.

Status Colors

Edit the configuration file, which determines
the status numbers and corresponding colors
used in the MCC.

System

Edit the configuration file, which determines
the MCC interfaces configuration and the
layout of the System Status Summary
window.

OS Group

Open the OS Group Editor for configuring
the Operating System Groups.

Max Scripts

Edit the gclrund.txt file to set the max
number of concurrent running scripts.

Pinger

Edit the gwPingerD.cfg.

Object Manager

Edit the configuration file which determines
the setup of Object Manager.

Fonts

Edit the configuration file which determines
the fonts used in the MCC. It is not
recommended to use this option. Use
extreme caution with this option.

Emulator

Edit the configuration files, which determine
soft key and keyboard remapping.

Other

Edit any file. Traverse the directory
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Use This Menu Item

To

structure and select the file to open.
Check
Configuration

Check the current MCC configuration files
for validity.
Table 12. Administration Menu Options

Starting a Unix Console
From the Administration menu of the Master window, select the Start Unix Console option. The
operating system for the MCC is DEC Unix. This option opens a MCC Unix console in a new
window.

Shutting Down the System
Shuts down the MCC software. A confirmation is requested.
Warning: The MCC is generally not shutdown. If the MCC is shut down,
all executing scripts are stopped, the processing of all event rules
is stopped, and all other users are forced to log off. Check with
the MCC administrator before shutting down the MCC.
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Appendix A Basic GUI Operation
This appendix describes the basic operations of the graphical user interface (GUI). Rather than
typing in lines of commands or memorizing pages of keystroke combinations, operations are
driven through picture and menu selections on the screen.
Each GUI system can be slightly different but the basic concepts and modes of operation are the
same. A general overview of GUI operation is provided in this chapter, with notes on the
specifics of the MCC terminal GUI operations.
This Appendix discusses the following:


Using the mouse.



Cursor.



Resizing a window.



Maximizing, restoring, and minimizing a window.



Selecting menus.



List boxes.



Drop-down list boxes.



Command buttons.



Text boxes.



Check boxes.



Radio buttons.



Cutting, copying, and pasting.
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Overview of GUI System
A GUI system allows the user to perform highly complex tasks without having to know the steps
required to accomplish the task. Through a menu or button, the user can access files, make
formatting changes, perform operations, and make changes. A GUI system also allows more than
one file or window to be open at the same time.

Mouse
In addition to the keyboard, a GUI system utilizes a device referred to as a mouse. A mouse is
generally smaller than the hand (unless you have very small hands). For most people, it fits in the
palm of the hand when the hand is palm-side down on the table or work surface.
The underside of the mouse has a ball that rolls whenever the mouse is moved on the table
surface and moves the cursor on the screen. The top side of the mouse has several parts. Toward
the heel of the hand is the casing over the ball component. In front of this, where the fingers rest,
are moveable sections referred to as buttons. The number of buttons on a mouse can vary.
Generally there are two or three. They are referred to as left, center, or right buttons. If the
mouse has only two buttons, the functions requiring the center button are performed by using
both buttons simultaneously.
The mouse performs tasks when the cursor is placed on the desired position on the screen and a
single or double click is used on the appropriate button.

Cursor
The cursor appears on the screen to identify the current location within a window or file. This
could be within the body of the window or file, the menu, or other defining areas. The cursor
could have several different forms, depending on where it is and the specifics of the system the
user is working in. The shape of the cursor at a given location identifies the function it can
perform there. In the MCC terminal GUI, the cursor can take the form of an X, an arrow, a t-bar,
an I, or a|.
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Resizing a Window
To change the size of a window:
1. Select the window to resize.
2. Place the cursor on a border or corner of the window. The cursor changes to the
drag arrow (↔).
3. Click-and-drag the corner or border until the window is the required size.
4. Release the mouse button.

Maximizing, Restoring, and Minimizing a Window
When a window is enlarged (maximized), it fills a larger portion of the desktop or even the entire
desktop. When a window is minimized, the window becomes an icon in the Icons window.
When a window is restored, the window returns to its previous size.
To enlarge a window to its maximum size:
1. Select the window to enlarge.
2. Click on the Open button in the upper-right corner of the window.
To minimize a window:
1. Select the window to reduce.
2. Click on the Minimize button in the upper-right corner of the window.
To restore a window, from the Icons Window, double-click the icon representing the window.

Selecting Menus
Choosing an option from a menu carries out a command or opens a dialog where more
information can be entered or selected.
To select a menu option:
1. Click on the name of the menu on the menu bar.
2. Click on the option you want.
Note:
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List Boxes
A list box contains a list of selections. If a list of selections is too long for the list box, a vertical
scroll bar appears so it is possible to scroll through the selections. Some list boxes also have an
associated selection box that displays the current selection. To select from a list box, click on the
item; it becomes highlighted.
It may be possible to choose more than one selection in some list boxes. If the selections are next
to each other, click on the first selection and then hold down the Shift key while clicking on the
last selection. If the selections are not next to each other, click on the first selection and then hold
down the Ctrl key while clicking on additional selections.

Drop-Down List Boxes
A drop-down list box is similar to a list box, except that only the current selection is initially
visible. To open the list of selections, click on the arrow. Click on a selection to highlight it.
When a selection is made, the drop-down list closes and displays the current selection.

Command Buttons
Command buttons execute commands in a dialog. For example, clicking on the OK button in a
dialog performs the action specified. Clicking on the Cancel button exits the dialog without
performing the action.

Text Boxes
Text boxes allow entry of text or numbers in a dialog. Text boxes appear in a variety of sizes and
shapes. To enter information in a text box, place the cursor in the text box and type. Use the
mouse to select existing text. Use the cursor and Delete keys to edit existing text.

Check Boxes
Check boxes allow selection of a specific attribute or function. Click on a check box to either
select or deselect it. An “X” in a check box means it is selected. An empty check box is not
selected.

Radio Buttons
Use radio buttons to select from a list of mutually exclusive options. When one radio button in a
group is selected, the previously selected radio button is automatically unselected. To select a
radio button, click on the button.

Cutting, Copying, and Pasting
The clipboard is a temporary storage area for cut or copied information. The information stays in
the clipboard until the next time information is cut or copied, or the user exits the MCC. Cutting
deletes the highlighted data. Copying leaves the data but copies the highlighted data to the
clipboard. Pasting pastes data from the clipboard.
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To cut information:
1. Highlight the data to cut.
2. Select the Edit menu Cut option.
To copy information:
1. Highlight the data to copy.
2. Select the Edit menu Copy option.
To paste data from the clipboard:
1. Select the insertion point.
2. Select the Edit menu Paste option.
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Appendix B MVS Mainframe Console Operation
Basics
Operating MVS system consoles in a MCC environment are no different than operating MVS
system consoles in a non-MCC environment. However, a review of common commands used to
control consoles is provided here, since MCC consoles frequently include “extra” consoles not
necessarily seen in typical MVS console configurations.

Basic VARY Options
As with any MVS console, customer site personnel assign addresses, update MVSCP/HCD, and
update the CONSOLxx member of PARMLIB for MCC consoles just as they do for standard
327x consoles. MCC administrators must inform operators of the assigned addresses and
operational procedures (if they vary from standard console operational procedures), so that the
consoles can be properly managed by operations personnel or automation routines.
Most MVS systems utilizing the MCC will have “printer” consoles assigned. A physical printer
console does not have a keyboard, and therefore may be designated as an OUTPUT ONLY
device. OUTPUT ONLY console device commands are preceded by “O-” (that is the letter O
followed by a dash). For example, to vary a standard (keyboard-attached console) online, the
user normally enters:
V xxx,ONLINE (use this format for I/O consoles)
If the device in question is an OUTPUT ONLY device, the user must enter:
V O-xxx,ONLINE (use this format for OUTPUT ONLY consoles)
If unsure, try entering the first format of the command; if it does not work, try the second format.
The same applies to OFFLINE commands:
V xxx,OFFLINE (use this format for devices to be used as I/O consoles)
V O-xxx,OFFLINE (use this format for OUTPUT ONLY devices to be used as consoles)
MVS defined consoles (see SYS1.PARMLIB member CONSOLxx) are not active as consoles
until they are “varied” into console status. Varying a console ONLINE does not make a
SYS1.PARMLIB defined (see member CONSOLxx) console recognizable to MVS as a console.
To do this requires another form of vary command, which should only be issued after the device
is ONLINE to MVS, as follows:
V xxx,CONSOLE (use this format for I/O consoles)
V O-xxx,CONSOLE (use this format for OUTPUT ONLY consoles)
The commands above should be issued once the device is in the ONLINE status. MVS takes care
of this during IPL, but console manipulation after IPL requires manual (or automated) commands
(as previously shown).
Also, certain error situations require additional MVS console commands. The following are
some commands that are most useful for operations:
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V xxx,OFFLINE,FORCE (use this format for I/O consoles that refuse to come offline with a
V xxx,OFFLINE command)
V O-xxx,OFFLINE,FORCE (use this format for OUTPUT ONLY consoles that refuse to
come offline with a V O-xxx,OFFLINE command)
Note:

For either of these commands, MVS will produce a WTOR to
“double check” if it is intended to FORCE this device offline.
Respond “YES”.

Once the console is offline due to one of the above commands, a standard “V xxx,ONLINE” or
“V O-xxx,ONLINE” will not suffice. Instead, one of the following commands must be issued:
V xxx,ONLINE,UNCOND (use this format for I/O consoles that have previously been taken
offline with a V xxx,OFFLINE,FORCE command)
V O-xxx,ONLINE,UNCOND (use this format for OUTPUT ONLY consoles that have
previously been taken offline with a V O- xxx,OFFLINE,FORCE command)

Buffer Limit Problems
In certain cases (for example, I/O errors due to cabling problems), a console (I/O or OUTPUT
ONLY) may “back up”. MVS will make the console operator(s) aware of this situation through
one or more messages (e.g., IEA404A, IEA405E). The message will state that a particular
console is reaching or has reached its buffer limit. This means that a number of messages are
“queued” to be delivered, but are being “held” by MVS pending resolution of the problem.
In a MCC environment, it is highly unlikely that the console in question is anywhere near the
console operators (they are frequently in another city, if not another state). In this case, as with
standard MVS, the operator must “relieve” the backup before the system begins to deteriorate
(causing undesirable results due to waits, timeouts, abends, etc.). This situation requires
immediate action, so that potential problems that could result from this backup are averted. The
simplest action is to issue a VARY online (see previous examples) to get the console out of
console status - this command returns the device to MVS device online status. MVS no longer
recognizes the device as an MVS console, although it still recognizes the device as being capable
of becoming a console via a VARY console command. Consequently, the “backup” condition is
alleviated immediately, through re-routing or simple elimination of the messages.
If the messages destined for the “backed up” console need to be “redirected” to a “live console”
(one that is currently functioning properly), the operator can issue the console redirection
command:
K Q,R=nn|name|HC{,L=cc|name)
where nn is the ID of the console device that the “backed up” messages are being routed to. If
this command is issued from the “backed up” console itself (which is unlikely), the L= keyword
and its operand are not required. This situation should never occur in the case of a “printer
console”, when the printer console is an OUTPUT ONLY device, since in that case it has no
keyboard to enter commands from. MVS consoles have IDs; they may or may not have names.
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Use the MVS command “D C” to see all the consoles that are currently assigned. Do this from
the MASTER console, or the console on which the message(s) appeared indicating that a console
was “backed up”. The numbers in the left-most portion of the line displays are the console IDs.
The numbers that follow the “/” (if any) are the alternate console IDs (the IDs of the console(s)
that are used to receive messages if the console whose ID to the left of the “/” fails).
At the same time, check the NBUF= value. A number that is in the hundreds (or thousands)
normally indicates a problem (especially if a “backed up” message has appeared). It is that
specific console (the high NBUF= console) whose ID is required if using the “K Q” type
recovery. Now, assuming the console that is backed up has an ID of 03, and the console that is
working) has an ID of 01, issue:
K Q,R=01,L=03
The messages that were “backed up” on console 03 will now be presented on console 01.
Earlier, it was suggested that issuing a VARY ONLINE is an easy way to escape from the
“backed up” problem. If you have not issued that command prior to issuing the “K Q” command,
it should (normally) be issued after the “K Q” command, because if a console is “backed up”,
there must be some sort of problem (for example, cable, or controller.). Issuing a “VARY
ONLINE” causes the console to go “out of service”, and the “alternate console” (if any) begins to
receive the messages originally destined for the “out of service” console. Issuing the “K Q” will
alleviate the problem, but it is most likely that manual intervention will be required to actually fix
the problem. If this is the case, the console should be put ONLINE (or taken OFFLINE) until the
problem is resolved, so another backup does not occur during problem resolution time. Issuing
the “K Q” prior to the offline command simply guarantees that the messages that were “backed
up” are not lost (assuming the R= console is available).
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Configuring a Console’s Characteristics
Roll Mode
To manually set the console’s message correctly rolling for MCC usage, do the following:
Note:

Anytime the system is re-IPLd, the rolling will have to be manually
set again. Therefore ensure roll setting is correct in the console gen
itself.

1. Enter K S
2. Change the MODE=x to MODE=R
3. Change the RTIM value for the number of seconds to wait before scrolling

Screen Positioning
To turn off split screen, enter:
K A,NONE (set area to none)
To reset from screen centering, enter:
K E,D

Active Console Information
To view information about the active console, enter:
D C,A
The information is displayed in the order:
Name

Address

ConsID

Where:
Name is the name of the device (if applicable)
Address is the address of the device on the controller
ConsID is the console id number
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VTAM 327x Console/Terminal
A VTAM console/terminal is a 327x type device.
Define VTAM consoles in the same way as an OS console described previously. However,
instead of updating CONSOLxx, simply update the VTAM definitions.
There are too many VTAM options available to provide examples here. In general, take care to
use only model 2 or 4 if the coax is plugged into a MCC CBUS coax card. This type of session
allows a user to log into TSO, CICS, IDMS, IMS, JOBTRACK, CA-7, etc., from the MCC.
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